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Preventing Toll Fraud

Toll Fraud is the unauthorized use of your telecommunications
system by an unauthorized party (for example, aperson who is not
a corporate employee, agent, subcontractor, or working on your
company’s behalf). Be aware that thereis arisk of toll fraud asso-
ciated with your system and that, if toll fraud occurs, it can result
in substantial additional charges for your telecommunications ser-
vices,

Avaya Fraud Intervention

If you suspect that you are being victimized by toll fraud and you
need technical assistance or support, call the Technical Service
Center’s Toll Fraud Intervention Hotline at 1.800.643.2353.

Providing Telecommunications Security

Telecommunications security of voice, data, and/or video commu-
nications is the prevention of any type of intrusion to, that is,
either unauthorized or malicious access to or use of, your com-
pany’s telecommunications equipment by some party.

Your company’s “telecommuni cations equipment” includes both
this Avaya product and any other voice/data/video equipment that
could be accessed viathis Avaya product (that is, “ networked
equipment”).

An “outside party” is anyone who is not a corporate employee,
agent, subcontractor, or working on your company’s behalf.
Whereas, a“malicious party” is Anyone, including someone who
may be otherwise authorized, who accesses your telecommunica-
tions equipment with either malicious or mischievous intent.

Such intrusions may be either to/through synchronous (time-mul-
tiplexed and/or circuit-based) or asynchronous (character-, mes-
sage-, or packet-based) equipment or interfaces for reasons of :
» Utilization (of capabilities special to the accessed equip-
ment)
» Theft (such as, of intellectual property, financial assets, or
toll-facility access)
» Eavesdropping (privacy invasions to humans)
» Mischief (troubling, but apparently innocuous, tampering)
* Harm (such as harmful tampering, dataloss or alteration,
regardless of motive or intent)
Be aware that there may be arisk of unauthorized intrusions asso-
ciated with your system and/or its networked equipment. Also
realize that, if such an intrusion should occur, it could result in a
variety of lossesto your company, including but not limited to,
human/data privacy, intellectual property, material assets, finan-
cial resources, labor costs, and/or legal costs).

Your Responsibility for Your Company’s Telecommunications
Security
Thefina responsibility for securing both this system and its net-
worked equipment rests with you — an Avaya customer’s system
administrator, your telecommunications peers, and your managers.
Base the fulfillment of your responsibility on acquired knowledge
and resources from a variety of sources including but not limited
to:

« Installation documents

¢ System administration documents

¢ Security documents

* Hardware-/software-based security tools

e Shared information between you and your peers

« Telecommunications security experts
To prevent intrusions to your tel ecommunications equipment, you
and your peers should carefully program and configure your:

* Avaya provided telecommunications systems and their

interfaces
* Avayaprovided software applications, aswell astheir
underlying hardware/software platforms and interfaces
* Any other equipment networked to your Avaya products

Trademarks
See the preface of this document.

Ordering Information

Call: Avaya Publications Center

Voice 1 800 457-1235 International Voice +1 207-866-6701
Fax 1800457-1764 International Fax +1 207-626-7269

Write: GlobaWare Solutions

200 Ward Hill Avenue
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For additional documents, refer to the section in “About This
Book” entitled “Related Resources.”

Obtaining Products
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www.avaya.com/direct or call 800-426-2455.

Comments
To comment on this document, return the comment card at the
front of the document.



Table of Contents

Preface . .. ... e
Purpose . .. 5
Prerequisites . ... ..o 5
Intended Audience ......... ... . ... 5
Conventions Used in ThisBook ............. ... ... .. ... ... 5
Additional Resources . ............. . 6
Tell Us What You Think! .......... ... . . . . . . .. 6
How to Get This Book (and Others) onthe Web ................ 7
How to Order More Copies of ThisBook ...................... 8
Chapter 1 — Resources and Notices. . ... ...........ccovuuuunn..
Avaya Technology and Consulting (ATAC) .................... 9
Avaya Remote Network Implementation Services (RNIS) ......... 9
Avaya Technical Service Organization (TSO) .................. 10
Avaya Network Management Software Systems
Support Group (NMSSS) . ... 10
Avaya Contact Information .................... . ... .c...... 10
Third-Party ReSOUICES . . .o v vttt e e et e e e e e 12
System Security NOTICES .. ... .. i 12
Network Security .. ...... ... i i 12
Toll Fraud Security . ......... ... 13
Chapter2 — OVerview . ... ..........uueeneeennnnnnnnnnenns 14
Product Description . ........... it 14
Supported SYStEIMS . . ..ot 15
System REqUITEMENtS . . . ..o vttt it i 16
Installation and Configuration Overview . .................... 17

Chapter 3 — Installing and Upgrading Fault and Performance

Manager. . .. ....... s 18
Customer Pre-Installation Tasks . ............ ... ........... 18
Completing the VMSO01I Form . ..., 18
Installing on LinuUX ... ..ottt 19
Configuring Fault and Performance Manager to Integrate with

HP OpenView . ... e 20

Avaya MultiVantage™ Fault and Performance Manager Installation and Configuration



Table of Contents

Installing Avaya NMSI Components on Windows . ............. 22
Installing the Java Development Kit . .................... 24
Installing Avaya NMSI Components ..................... 24
Finishing the Installation .. ............ ... ... ... ...... 25

Configuring Fault and Performance Manager for

Stand-Alone Operation ...............c.couiiiiininnnn.. 26

Installing the Fault and Performance Manager Client on Windows 27
Starting the Installation . ......... ... ... . .. ... . ... 27
Installing the Java Runtime Environment ................ 29
Installing the Required Components ..................... 30
Finishing the Installation .. ............ ... ... ... ...... 31

Uninstalling Fault and Performance Manager ................. 31

Chapter 4 — Customizing Fault and Performance Manager . . . ... 33

INtroduction . . ... ... e 33

Setting up Native AGENt . ... ..ottt 33

System COmMMmMAandS . ... ...vuime ettt 34
Start and Stop Commands . .. ... .. 34
System Health Commands . ................ ... ... .... 34

Backing up the Database ......... ... ... .. .. ... 35

Restoring the Database .......... ... .. .. .. . 36

Administering Alarm Notification Services ................... 37
Description of Alarm Notification Options ................ 37
DEFINITY_ARS SCIIpt ...ttt 39
AUDIX_ARS SCIIPt « . oot 40
CMS_ARS SCIIPt .« oot 41
CONVERSANT_ARS SCIipt .« oottt 42

Chapter 5 — Getting Started ... ...............ccciiiiiiinnn. 44

Executing Auto-DISCOVETY . ... .ttt e 44

Starting the Administrative GUI .. ........ ... ..., 45

Exiting the Fault and Performance Manager

Client from the Linux Server ................ ... 46

Starting the Fault and Performance Manager

Client from a Web Browser . ...............uuiiiuenneo... 46
Startingthe Online Help ... ......... ... . ... . . . .. 48
Exiting the Fault and Performance Manager

Client from a Web Browser . ............c..uiiiiuneneeen.. 48

Fault and Performance Manager Integration with NMS ......... 48
Understanding the NMS Maps .. .......vviiinnnnnnnnnn. 48
Root Map . ... . e 49

Executing Commands from NMSMaps ................co.... 52
Description of Commands . .......... ... ... ... ... ... .. 53

Glossary and Abbreviations . . .................0 i, 58
Index. . ... . e 59

4 Avaya MultiVantage™ Fault and Performance Manager Installation and Configuration



Preface

Purpose
This book explains how to install and set up Avaya MultiVantage™
Fault and Performance Manager (Fault and Performance
Manager).

Prerequisites

Installing and configuring Fault and Performance Manager requires
familiarity with network administration, knowledge of the Red Hat
Linux operating system, and proficiency with Linux
administration. This knowledge is not delivered in this book but is
essential for a successful installation.

For this reason, we highly recommend that workstation or
network administrators take the primary role in installation.

Intended Audience

We wrote this book for workstation or network administrators.

Conventions Used in This Book

In this book, we use the following typographical conventions:

e We use bold type for emphasis and for any information that
you should type; for example: save translation.

e We use Courier font for any information that the computer
screen displays; for example: | ogi n.

e We use arrows to indicate options that you should select on
cascading menus; for example: “Select File>Open” means
choose the “Open” option from the “File” menu.

Avaya MultiVantage™ Fault and Performance Manager Installation and Configuration 5



Additional Resources

Additional Resources

You may find the following additional resources helpful.

For help using Fault and Performance Manager, see the Fault and
Performance Manager online help. It explains how to perform basic
administration tasks. To access the online help, start Fault and
Performance Manager and choose Help>Help Topics.

For help with complex administration tasks, use the Administrator’s Guide
for Avaya MultiVantage™ Software, which explains system features and
interactions in detail. You can access this document from the VisAbility
home page.

Tell Us What You Think!

Let us know how this book measured up to your expectations. Your
opinions are crucial to helping us meet your needs! You can send us
your comments by mail, fax, or e-mail, as follows:

Mail: Avaya, Inc.
Fault and Performance Manager Documentation Team
Room 1E-124
307 Middletown Lincroft Rd.
Lincroft, NJ 07738
USA

Fax: Fault and Performance Manager Documentation Team
+1732817-2469

E-mail: document@avaya.com
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Preface

How to Get This Book (and Others) on the Web

To view or download the latest version of this book, complete the
following steps:

1. Install your internet browser.
Most computers are sold with browsers already installed.
2. Get access to the Internet.

If you do not already have access to the Internet, contact an
Internet Service Provider (ISP) and set up an account.

3. Set up your browser preferences.
Refer to the documentation that came with your browser.
4. Install Adobe Acrobat Reader with Search, version 5.0 or later.

This is available on your CD-ROM or from: http://
www.adobe.com.

5. Access http://www.avaya.com/support
6. Click Product Docunent ati on.
7. Click Syst em and Networ k Managenent .

8. Under the heading “VisAbility Management Suite,” locate the
heading, “MultiVantage Fault and Performance Manager” and
then click the link corresponding to the software release for
which you want documentation.

9. Locate the title of the book you want and then click it.

Avaya MultiVantage™ Fault and Performance Manager Installation and Configuration 7



How to Order More Copies of This Book

How to Order More Copies of This Book

To order paper copies of this book, call or write us and request the
following publication:

Order: Document Number:555-233-138
Issue: Issue 3
Date: November 2002

Call:  Avaya Publications Center
Voice: 1 800 457 1235
Fax: 1 800 457 1764

If you are calling from somewhere that cannot access US 1-
800 numbers, then call:

Voice: +1 207 866 6701

Fax: + 1207 626 7269

Write: Globalware Solutions
200 Ward Hill Avenue
Haverhill, MA 01835
USA
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1 Resources and Notices

Avaya provides a variety of planning, consulting, and technical
services. The sections below briefly describe the resources and
services that are available.

Client executives are your primary contact to obtain information
and explore options to meet your specific business needs.

Avaya Technology and Consulting (ATAC)

ATAC works with client teams to develop detailed solutions for
connectivity to MultiVantage™ solutions. The ATAC also designs
network configurations to support Fault and Performance Manager
and Avaya MultiVantage™ Proxy Agent (Proxy Agent).

Avaya Remote Network Implementation
Services (RNIS)

For this product, RNIS offers customers the following services:

e Verity platform readiness
¢ Remotely install Fault and Performance Manager

e Configure the network management server for each voice
system to be managed by Fault and Performance Manager

e Verify customer acceptance

e (Custom on-site services

Avaya MultiVantage™ Fault and Performance Manager Installation and Configuration 9



Avaya Technical Service Organization (TSO)

Avaya Technical Service Organization (TSO)

The TSO provides support for Fault and Performance Manager and
Proxy Agent to client teams, field technicians, and customers. The
TSO will bill customers for support on a time and materials basis if
the following conditions exist:

e Customers do not have a current maintenance agreement

e (Customers do not procure and install the required systems
and software as defined in the VisAbility Management Suite
Services Support Plan

e Customers request support that is outside the purchase
agreement

The TSO does not support hardware or software that customers
purchase from third-party vendors.

Avaya Network Management Software Systems
Support Group (NMSSS)

The Network Management Software Systems Support (NMSSS)
group in Tampa Bay, Florida answers customer calls about
applications in the VisAbility Management Suite. NMSSS will
either answer your questions directly or connect you with an
associate who can answer questions about your application.

Avaya Contact Information

You may find the following contact information helpful at various
times during the process of installing and setting up this product
This information was accurate at the time this book went to press.
We update this information with each new release of Fault and
Performance Manager.
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Resources and Notices

Customers can access only the resources in Table 1 (not Table 2). To view
Avaya web sites, Avaya recommends that you use Internet Explorer.

Table 1. Customer-Accessible Resources

Resource Contact Information

Avaya Support Center http://support.avaya.com/

Network Management 1-800-237-0016.
Software Systems

Support group

Remote Network http://www]l.avaya.com/enterprise/who/
Implementation Services | docs/implementationservices/

(RNIS) tullprodinfo.html

Toll Fraud Intervention | 1-800-643-2353 prompt 1

Table 2. Avaya Internal Resources

Resource Contact Information

Avaya Enterprise http://aem-support.dr.avaya.com/
Management Support

Avaya Technology and Phone: 1-888-297-4700, prompt 2, 6
Consulting (ATAC) Main site (requires a password):

http://forum.avaya.com

Remote Network http://associate2.avaya.com/sales_market/
Implementation Services | products/data-implementation-services/
(RNIS)

VisAbility Management | http://associate2.avaya.com/solution/
Services Support Plan support_plans/#Enterprise

VMSO001 Form http://associate2.avaya.com/sales_market/

products/data-implementation-services/

Then click “Avaya VisAbility™ Management
Suite Configuration Request Form #1.”

Avaya MultiVantage™ Fault and Performance Manager Installation and Configuration 11
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Third-Party Resources

Third-Party Resources

The table below lists contact information for third-party vendors.

Table 3. Vendor web sites

Vendor Web Sites

Hewlett-Packard Main site: http.//www.openview.hp.com
Microsoft Main site: http://www.microsoft.com
Red Hat Linux Main site: http://www.redhat.com
Peregrine Main site: http://www.peregrine.com

Scroll down to: action request system
Vytek Main site: http://www.vytek.com

Versant Main site: http:.//www.versant.com

System Security Notices

Customers are solely responsible for the security of their system,
network, and access to hardware and software. The sections below
define the precautions that all customers should take to maintain
the security of their systems.

Network Security

Fault and Performance Manager uses the standard security features
on the Red Hat Linux and Windows 2000 operating systems.

Avaya strongly recommends that customers use passwords to
prohibit access to their systems and to routinely change those
passwords to maintain security.

A SECURITY ALERT:

Customers should always change passwords immediately
after external vendors have completed installation,
maintenance, troubleshooting, or other tasks on their
system.
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Resources and Notices

Toll Fraud Security

Although Fault and Performance Manager is generally not at risk for toll
fraud, customers are solely responsible for the security of their entire
telecommunications system.

Toll Fraud is the unauthorized use of a company’s telecommunications
system by unauthorized parties. Unauthorized parties are persons other
than the company’s employees, agents, subcontractors, or persons
working on behalf of the company. Toll fraud can result in substantial
additional charges for the company’s telecommunications services.

The company’s system manager is responsible for the security of the
company’s system, which includes programming and configuring the
equipment to prevent unauthorized use.

Avaya Avaya does not warrant that this product is immune from or will prevent

Disclaimer unauthorized use of common-carrier telecommunications services or
facilities accessed through or connected to it. Avaya will not be
responsible for any charges that result from such unauthorized use.

Toll Fraud If customers suspect that they are a victims of toll fraud and need
Intervention technical assistance, they should refer to the phone number listed for
"Toll Fraud Intervention" on page 11.

Avaya MultiVantage™ Fault and Performance Manager Installation and Configuration 13



2 Overview

Avaya MultiVantage™ Fault and Performance Manager (Fault and
Performance Manager) together with Avaya MultiVantage™ Proxy
Agent (Proxy Agent) provide a complete solution to fault and
performance management of Avaya voice elements in the stand-
alone mode as well as in an NMS integrated mode.

These products provide a view of the health and performance of
your network systems. Fault and Performance Manager and Proxy
Agent work together as an integrated application.

Product Description

Fault and Fault and Performance Manager provides graphical and tabular
Performance tools to monitor the status and performance of a network of
Manager supported systems and external devices.
Fault and Performance Manager collects configuration, fault, and
performance data from Proxy Agent using SNMP and then displays
the data in text, tables, and graphic formats.
The primary features of Fault and Performance Manager include:

e Graphical User Interface (GUI) -- The main window
contains a navigation tree that lists all the supported
systems and displays a colored alert symbol that indicates
highest exception level. You can expand the list to view all
of the configuration components and specific alert symbols
for each component.

e Configuration -- You can view the configuration and
administered properties of all supported systems (managed
nodes) in both a graphic view and a table view.

¢ Administration -- You define the system-wide parameters
for the features below:

— Data collection -- You define the parameters for the
data to be collected from each system, including the type
of data, the schedule for collecting data, and the length
of time to store the data.
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Overview

— Exception logging -- You define the conditions to log
exceptions for performance thresholds, faults, and system
errors.

— Exception alerting -- You specify the alert levels for
exceptions from each supported system. Alert levels may
include exceptions that are critical, major, minor, or warning.
The alert level and location of the exception appear in the
main window as long as the exception exists.

Report Manager -- You can define the parameters for individual
reports for all or selected systems. The report options include:

— Performance
— Configuration
— Exceptions

You can view the reports on screen in both the table and chart
formats or direct the reports to a printer, HTML file, GIF file, or
ASCII file.

Scheduled Reports -- You can schedule reports to run on a
daily, weekly, or monthly basis, and edit and delete schedules as
needed.

Supported Systems

Fault and Performance Manager Release 1.2 supports both SNMP V1
and V2c get and set requests and SNMP V1 alarm traps for the following
systems:

DEFINITY® ECS Releases 9.2 through 10.x

Avaya MultiVantage™ Software

Survivable Remote Processors (SRPs)

Multipoint Conferencing Unit (MCU) Release 6.0 and later
Avaya™ G600 Media Gateway

Avaya™ CMC1 Media Gateway

Fault and Performance Manager treats SRPs and MCUs as MultiVantage
solutions.
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System Requirements

Fault and Performance Manager Release 1.2 supports only alarm
traps for the following systems:

e DEFINITY AUDIX Releases 3.1 through 4.0

e INTUITY AUDIX Release 4.3 through 5.1 (with or without
the remote maintenance board)

e Intuity Interchange Release 5.1 through 5.3
e (Call Management System (CMS) R3V6 through R3V8

¢ CONVERSANT Release 7.0

System Requirements

Hardware You should work with your Avaya client team to determine the
hardware requirements that meet your business and performance
specifications. Your client team has access to the VisAbility
Management Suite Services Support Plan, which contains the
information they need to help you determine hardware
requirements in your situation. Your client team can download the
package from the URL listed in Table 2 on page 11.

Hardware Avaya requires that Fault and Performance Manager hardware
Certification must be Red Hat Linux 7.3 certified. For the Red Hat URL, see
"Third-Party Resources" on page 12.

Customers are solely responsible for upgrading their
A CAUTION: network platforms to meet the NMS platform requirements
for Fault and Performance Manager Release 1.2.

Software Fault and Performance Manager Release 1.2 operates on Red Hat
Linux 7.3. The optional NMSI component runs on Windows 2000
running HP OpenView 6.2.
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Overview

Installation and Configuration Overview

The installation and configuration process will follow the basic steps
listed below:

1. Customers complete the "Customer Pre-Installation Tasks" on
page 18.

2. Customers communicate with RNIS to verify server readiness,
finalize technical details, and confirm implementation schedule.

3. (For upgrades only:) Complete the procedure, "Backing up the
Database" on page 35.
4. Installers complete "Installing on Linux" on page 19.

i

. If you will be running Fault and Performance Manager with a
Network Management System (NMS), then installers should:

a. Complete the procedure, "Configuring Fault and Performance
Manager to Integrate with HP OpenView" on page 20.

b. Complete the procedure, "Installing Avaya NMSI Components
on Windows" on page 22.

=)

. If you will be running Fault and Performance Manager
“standalone,” the installers should complete the procedure,
"Configuring Fault and Performance Manager for Stand-Alone
Operation" on page 26.

~

. Installers complete "Installing the Fault and Performance Manager
Client on Windows" on page 27.

8. Installers complete "Administering Alarm Notification Services"
on page 37.

9. If you will be running Fault and Performance Manager with an
NMS, then installers should complete"Executing Auto-Discovery"
on page 44.

10. If you want to use Fault and Performance Manager to collect
data, create and save report definitions, and schedule reports,
then installers should complete "Starting the Administrative GUI"
on page 45.

Avaya MultiVantage™ Fault and Performance Manager Installation and Configuration 17



Installing and Upgrading Fault
and Performance Manager

This chapter explains how to install Avaya MultiVantage™ Fault
and Performance Manager (Fault and Performance Manager)
Release 1.2 as a new or upgrade installation.

In this document, Proxy Agent refers to either DEFINITY Proxy
Agent (DPA) or Avaya MultiVantage™ Proxy Agent (Proxy Agent).

Customer Pre-Installation Tasks

Before Fault and Performance Manager can be installed, customers
must complete the several tasks that are defined in the VisAbility
Management Suite Services Support Plan. Your client team can
download the plan from the URL specified in Table 2 on page 11.

One of those tasks is to set up your Linux server. Instructions for
doing so are in the Avaya VisAbility Management Suite
Implementation Guidelines, which is available from your client
executive. The instructions are also available in the Configuring
Red Hat Linux document, which is available under the “VisAbility”
heading of the System and Network Management area of the
Support Centre web site. (see "How to Get This Book (and Others)
on the Web" on page 7).

Completing the VMS001 Form

The VMS001 form stores information that an installer needs when
installing and configuring Fault and Performance Manager. The
form also stores information that Avaya would need when
troubleshooting and or maintaining Fault and Performance
Manager. Your client team has access to the form and may ask for
your input in completing the form. The VMS001 form must be
completed for new installations and for any upgrades or changes.

Avaya MultiVantage™ Fault and Performance Manager Installation and Configuration



Installing and Upgrading Fault and Performance Manager

Installing on Linux

This section explains how to install Fault and Performance Manager. The
installation script has been updated to simplify the process.

Required Assemble the following materials and information:
Materials
— This book

— "Avaya VisAbility Management Suite: Linux Server
Installation" CD-ROM

— Completed VMS001 form
— Root name and password
* Note: You must reboot your system after installing Fault and

Performance Manager.

Default The sections below describe the prompts in the order that they presented

options in the installation script. The default options help you to maintain
consistency when upgrading to new releases. The installation script
overwrites previous settings during the installation process.

Procedure Complete the procedure below to install Fault and Performance
Manager.

1. Ask all users to log off the system.

2. Close all open windows and applications.

3. At the login prompt, type root and press ENTER.

4. At the password prompt, type the root password and press ENTER.

5. Insert the "Avaya VisAbility Management Suite: Linux Server
Installation" CD-ROM into the CD-ROM drive.

6. Open a terminal window.
7. Type c¢d /mnt/cdrom
8. Type vms_setup.bin and press ENTER.

The message “Initializing wizard.” appears followed by the
Welcome screen.

9. Click NEXT and follow the prompts to complete the installation.
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Configuring Fault and Performance Manager to Integrate with HP OpenView

10. Do one of the following:

— If you are installing a stand-alone system, go to
"Configuring Fault and Performance Manager for Stand-
Alone Operation" on page 26. or

— If you are installing the HP OpenView integrated
version, complete the next section.

Configuring Fault and Performance Manager to
Integrate with HP OpenView

To use the NMSI portion of the offer, before beginning the
A CAUTION: following configuration process, you must have

HP OpenView for Windows NT/2000 Version 6.2 installed

and running.

Complete the procedures below to configure Fault and
Performance Manager to Integrate with HP OpenView.

1. At the login prompt, type root and press ENTER.

2. At the password prompt, type the root password and press
ENTER.

3. Open a terminal window.

4. At the Linux prompt, type /usr/sbin/mfpmconfig and press
ENTER.

The system displays the prompt:

Do you want to reconfigure the MiltiVantage Faul t
and Performance Managenment software [yes]

5. Type yes and press ENTER.
The system displays the prompt:
Shutting down MFPM Server services:
Configuring environnent:

Mul ti Vant age Fault and Perfornmance Managenent
require a print conmand to be specified. This
command will be used by the application when
attenpting to print reports to a printer. The
keyword “9%ile” can be used in the print not
appear here, the filename will be appended to the
print conmand. Please enter a default print
comuand to be used by the MFPM appli cations

Enter printer command [ ]
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Installing and Upgrading Fault and Performance Manager

6. Type the print command and press ENTER.
The print command is on the VMS001 form.
The system displays the message:

Mul ti Vantage Fault and Perfornmance Managenent can
integrate with an HP OpenVi ew Net wor k Node Manager
system It provides for MultiVantage System Vi ew whi ch
shows | ogi cal connectivity anongst MiltiVantage | P
tel ephony endpoints. Refer to the MiltiVantage Fault
and Perfornmance Management docunentation for nore

i nformati on about the HP OpenView NMS | ntegration.

Do you want to integrate MFPM with an HP QOpenVi ew
Systen] 17

7. Type yes and press ENTER.

The system displays the message:

In order for this capability to work, information
regarding the I P connectivity with the HP OpenVi ew
server nust be established.

Enter the HP OpenView Server | P Address [ ]
8. Type the HP OpenView server IP address and press ENTER.

The system displays the message:

When the Mul ti Vant age Fault and Perfor nance Managenent
HP OpenView NVSI is installed, a service for the NVSI
SNWP Configuration service will be set up. The TCP
port nunber that this service is using on the HP
QpenVi ew NVBI server nust be entered at this tine. If
you do not know the TCP port nunber yet, just select
the default and run nfpntonfig at a later tine after
the NVBI HP QpenVi ew Conponent has been installed on
the HP QpenVi ew server.

Enter the HP OpenVi ew Server Config Service TCP Port
Nunber you want to integrate MFPMwith an HP QpenVi ew

System|[ ]?
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Installing Avaya NMSI Components on Windows

9. Type the HP OpenView server contig service TCP port
number and press ENTER.

(This number is on the VMS001 form)

Avaya voice related objects will be placed on the HP
OpenView maps. A specific map can be identified as the
repository for where the Avaya objects will be placed. By
default, HP OpenView’s default map name is “default”. If
you use a different HP OpenView map, that map name
needs to entered here. If you are not sure just accept the
default setting.

Enter the HP OpenView Server Map Nane [defaul t]
10. Press ENTER.

The system displays the following messages:
Configuring MFPM Java Environnent. ..
Confi guri ng MFPM NMSI Environment. ..

Modi fyi ng MFPM Properties in Wb Cient JAR
file...

Bui | di ng environnent file...
Pl atform configurati on conpl ete.
Starting MFPM Server services:

Mul ti Vant age Fault and Perfornnance Managenent
software configuration was successful.

11. At the Linux prompt, reboot the system by typing the
shutdown command type cd/; /sbin/shutdown -r and press
ENTER.

The system reboots. This takes several minutes.

Installing Avaya NMSI Components on Windows

Complete the procedure below if you plan to run Fault and
Performance Manager integrated with an NMS.

1. Shut down all applications.

2. Insert the "Avaya VisAbility Management Suite: Windows
Server Installation” CD into the CD-ROM drive.

Wait a moment for the autorun application to appear
automatically
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3. Click Install Network Management Products.
The installation program will display a welcome page.
4. At the Welcome page, click Next.

The installation program displays a list of the applications that
you can install. If HP OpenView is detected on the machine, the
NMSI Components for HP OpenView check box will be enabled.
Otherwise, it will be disabled.

5. Select NMSI Components for HP OpenView, along with any other
programs you want to install.

6. Verity that you have enough available hard disk space on your PC
to install the application.

7. Check the summary page and do one of the following:
a. If it contains errors, click Back to correct the errors.
b. If it is accurate, click Finish.

A note advises you that if an installation wizard asks you if
you want to reboot, you should NOT reboot until the final
installation wizard has run. Click OK.

Depending on which options you selected in Step 5, the master
installation wizard launches one or more of the following
installation wizards, in the following order:

— Netscape installation wizard

— Java Development Kit installation wizard
— Apache Web Server installation wizard
— Apache Tomcat installation wizard

— Avaya ATM WAN Survivable Processor Manager installation
wizard

— VisAbility Management Home Page installation wizard

— Avaya VoIP Monitoring Manager installation wizard

— Avaya Directory Enabled Management installation wizard
— Adobe Acrobat Reader installation wizard

— Avaya MultiService Network Manager installation wizard
(this will prompt for the MultiService Network Manager CD)
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Installing the Java Development Kit

1. Read the terms and conditions of the Sun license agreement,
and do one of the following:

a. If you agree to the terms and conditions, click Yes.

b. If you do not agree to the terms and conditions, click
Cancel.

Doing so will terminate the installation wizard for this
application. The installation program will display the
wizard for the next application that you selected (if any)
in Step 5 on page 23. In that event, refer to the
installation document for that application and skip the
rest of this procedure.

2. Specify the location where you want to install the JDK and
click Next.

To change the location, click Browse and navigate to where
you want to install the JDK.

3. Specify the browser(s) that you want the JRE plug-in to
work with and click Next.

A list of options appears.
4. Leave everything selected (default) and click Next.

The wizard installs the Java Runtime Environment.

i

. Select No, I will restart my computer later and click Finish.

Installing Avaya NMSI Components

1. At the Welcome screen, click Next.
2. Specify the location where you want the files to be installed.

Note: This is not the final location of the files. Files will be
moved from the installation location into various areas of
the HP OpenView product.

3. Enter the computer name or fully-qualified domain name
(FQDN) of the Fault and Performance Manager server
computer and click Next.

The FQDN is the host name followed by the IP domain
name. For example: dnapcl. depart nent . conpany. com
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4. Enter the port number that the Fault and Performance Manager

server expects to communicate to the NMSI components with
and click Next.

5. Check the summary page and do one of the following:
a. If it contains errors, click Back to correct the errors.

b. If it is accurate, click Finish.

A note advises you that if an installation wizard asks you it

you want to reboot, you should NOT reboot until the final
installation wizard has run. Click OK.

Finishing the Installation

After the final wizard runs, a message appears indicating that the
installation is complete and that you can now reboot your computer (if
any of the installation wizards indicated that this was necessary). To
finish the installation, complete the following steps:

1. On the CD Browser screen, click Exit.
2. Remove the CD from the CD-ROM drive.

3. Reboot (if appropriate).
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Configuring Fault and Performance Manager for
Stand-Alone Operation

Complete the procedure below to configure Fault and Performance
Manager for stand-alone operation. Skip this section if you do not
plan to run Fault and Performance Manager standalone.

1.

2.

At the login prompt type root and press ENTER.

At the password prompt, type the root password and press
ENTER.

. Open a terminal window.

At the Linux prompt, type /usr/sbin/mfpmconfig and press
ENTER.

The system displays the prompt: Do you want to
reconfigure the MiltiVantage Fault and
Per f or mance Managenent 1.0 software [yes]

. Type yes and press ENTER.

The system displays the message:
Shutting down MFPM Server services:
Configuring environnent:

Mul ti Vant age Fault and Perfornmance Managenent
require a print conmand to be specified. This
command will be used by the application when
attenpting to print reports to a printer. The
keyword “9%ile” can be used in the print not
appear here, the filename will be appended to the
print conmand. Please enter a default print
comuand to be used by the MFPM appli cations

Enter printer command [ ]

. Type the print command and press ENTER.

The system displays the message:

Mul ti Vant age Fault and Performance Managenent can
integrate with an HP OpenVi ew Net wor k Node
Manager system It provides for MiltiVantage
System Vi ew whi ch shows | ogi cal connectivity
amongst Mul ti Vantage | P tel ephony endpoints.
Refer to the MultiVantage Fault and Perfornance
Managenent docunentation for nore infornmation
about the HP QpenVi ew NMB I ntegration.
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Do you want to integrate MFPM with an HP QpenVi ew
Systen] 17

7. Type no and press Enter.
The system displays the messages:
Configuring MFPM Java Environnment. ..
Configuring MFPM NMSI Environment. ..
Modi fying MFPM Properties in Web Client JARfile...
Bui | di ng environnent file...
Pl atform confi gurati on conpl ete.
Starting MFPM Server services:

Mul ti Vant age Fault and Perfornance Managenent
software configuration was successful.

8. At the Linux prompt, reboot the system by typing
cd/; /sbin/shutdown -r and pressing ENTER.

The system reboots. This takes several minutes.

Installing the Fault and Performance Manager
Client on Windows

To install Fault and Performance Manager clients, you must use a
Windows login that has Administrator privileges. Then, complete the
following sections.

Starting the Installation

1. Shut down all applications running on the PC.

2. Insert the "Avaya VisAbility Management Suite: Windows Client
Installation” CD into the CD-ROM drive.

Wait a moment for the CD browser window to appear
automatically.

3. Click Install Network Management Client Products.

The installation program prepares the installation wizard and
displays the Welcome page.
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4. At the Welcome page, click Next.

The installation program displays a list of the applications
and shortcuts that you can install. By default, the option for
Required Components is checked.

5. Select Shortcut for MultiVantage Fault and Performance
Manager, along with any other programs or shortcuts you
want to install.

6. Verify that you have enough available hard disk space on
your PC to install the shortcut(s).

a. If you don't, click Cancel to exit the installation
program.

Restart the installation at Step 1 when you have made
adequate hard disk space available.

b. If you do, click Next.
The installation program displays the summary page.
7. Check the summary page and do one of the following:
a. If it contains errors, click Back to correct the errors.
b. If it is accurate, click Finish.

A note advises you that if an installation wizard asks you
if you want to reboot, you should NOT reboot until the
final installation wizard (in your situation) has run.
Click OK.

* Note: If at any time during the installation you see a wizard
that asks you if you want to reboot, DO NOT SAY
YES until you are certain that the final installation
wizard has run.

Depending on which options you selected in Step 5, the
“master installer” program launches one or more of the
following installation wizards, in the following order:

—Netscape installation wizard

—Java Runtime Environment (only if you select a
shortcut, Directory Enabled Management, or VAL
Manager)

—Required components installation wizard

—Avaya Site Administration installation wizard
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—Avaya Terminal Emulation installation wizard

—VAL Manager installation wizard

—VoIP Monitor installation wizard

—System Management Client Shortcuts installation wizard.
—Adobe installation wizard

This book explains only the screens that appear if you select
the Fault and Performance Manager shortcut option. If you
select additional options, you may see other screens in
between the ones described below.

Installing the Java Runtime Environment

First, The Java Runtime Environment installation wizard runs.

1. Read the terms and conditions of the Sun license agreement, and
do one of the following:

a. If you agree to the terms and conditions, click Yes.
The installation wizard displays any Release Notes.
b. If you do not agree to the terms and conditions, click Cancel.

This will terminate the installation wizard for this application.
The installation program will display the wizard for the next
application that you selected (if any) in Step 5. In that event,
refer to the installation documentation for that
application and skip the rest of this procedure.

2. Specifty the location where you want to install the JRE and click
Next.

To change the location, click Browse and navigate to where you
want to install the JRE.

3. Specify the browser(s) that you want this JRE plug-in to work
with and click Next.

The installation wizard copies the necessary files to your
computer, then displays a message and exits when the installation
is complete.

Then, the Required Components installation wizard runs.
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Installing the Required Components

When you install the Required Components, the installation
program sets up files so that you can launch applications from the
VisAbility home page.

1. At the Welcome screen, click Next.

2. Specify the location where you want to install the Required
Components and click Next.

To change the location, click Browse and navigate to where
you want to install the Required Components.

3. Enter the computer name or FQDN of the VisAbility
Network Management Server.

The VisAbility Network Management Server is either a
Windows server or a Linux server. It is the location where
this client PC will look for the VisAbility Management web
page. If you have installed (or plan to install) both the
Windows server and the Linux server, enter the Windows
server information here. If you have installed (or plan to
install) only the Linux server, then enter the Linux server
information here.

You can type the computer name or the FQDN. The FQDN is
the host name followed by the IP domain name. For
example: dnapcl. depart nment. conpany. com

4. Check the summary page and do one of the following:
a. If it contains errors, click Back to correct the errors.
b. If it is accurate, click Next.

The installation wizard displays a message that the
installation of Required Components is complete.

5. Click Finish.
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Finishing the Installation

After the final wizard runs, a message appears indicating that the
installation is complete and that you can now reboot your computer if
any of the installation wizards indicated that this was necessary. To finish
the installation, complete the following steps:

1. On the CD Browser screen, click Exit.
2. Remove the CD from the CD-ROM drive.
3. Reboot (if appropriate).

Repeat this process, starting at "Starting the Installation" on page 27, on
all other Windows computers that you want to serve as Fault and
Performance Manager clients.

Uninstalling Fault and Performance Manager

This section explains how to remove Fault and Performance Manager.
This procedure contains only the basic steps. For more information on
the Linux package uninstall, refer to the Linux system documentation.

A CAUTION: To preserve current data, back up data to a file or archive device.

Procedure Only root users should remove Fault and Performance Manager. The

remove script prompts you to back up the database to a file or an archive
device.

1. Close all windows and applications.
2. Log off the network server.

3. Optional. If you are backing up the database before you remove
Fault and Performance Manager, connect the archive device.

4. At the login prompt, type root and press ENTER.

5. At the password prompt, type the root password and press ENTER
6. Open a terminal window

7. Type cd/ usr/local/avaya/uninstall and press ENTER.

Doing so sets up the Fault and Performance Manager
environment.
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8. Type . /uninstaller.bin and press ENTER.

The installation wizard appears followed by the Welcome
screen.

9. Select the application to be removed

10. Click NEXT and follow the wizard prompts.
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Performance Manager

Introduction

Only the system administrator or root user should edit the files that
allow you to customize Avaya MultiVantage™ Fault and
Performance Manager (Fault and Performance Manager).

The information in this chapter allows system administrators to
manage the options below:

Set up the MultiVantage Sub Agent on your MultiVantage
software

Control the NMSI polling of Proxy Agents

Override the default location submaps that are administered
on Proxy Agents

Execute system commands to start and stop Fault and
Performance Manager and to view the system health status

Execute database commands

Edit system configuration files to customize Fault and
Performance Manager

Integrate third-party products for alarm notification

Setting up Native Agent

For instructions on setting up the MultiVantage Sub Agent on your
MultiVantage software, see the Administrator’s Guide for Avaya
MultiVantage Software, 555-233-506 Issue 5, page 564 The section
is titled, “SNMP Agents” in Chapter 17, “Administering Media
Servers.”
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System Commands

Start and Stop Commands

Fault and Performance Manager processes normally start from
Linux inittab. The commands in the table below give the system
administrator additional control of the Fault and Performance
Manager processes.

Table 4. Start and Stop commands

Command Description

service mfpm-server stop Stops the Fault and Performance
Manager system and prevents it
from starting at system boot.

service mfpm-server start Starts a stopped Fault and
Performance Manager system and
enables it to start at system boot.

service mfpm-server restart | Stops and immediately restarts the
Fault and Performance Manager
system.

System administrators can view a log of system startups and
shutdowns from /var/avaya/mfpm/logs/MsgLog_[0-2]

System Health Commands

The table below contains the system health commands.

Table 5. System Health commands

Command Description

service mfpm-server status Displays Fault and
Performance Manager system
process status

/usr/local/avaya/mfpm/bin/MFPM gui | Opens a graphical monitor of
process status
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Backing up the Database

Required
materials

Procedure

Only the root user should execute the procedure to back up the
database.

You can execute the BackupMFPM utility to back up the database during
installation or at any time after the product is installed.

You will need the following materials and information:

Root login and password

File name or device name to back up the database

Complete the procedure below to back up the database.

. Close all windows and applications.

. Optional. Connect the archive device.

. At the login prompt type root and press ENTER.

. At the password prompt, type the root password and press ENTER.

. Type service mfpm-server stop and press ENTER.

This shuts down Fault and Performance Manager services.

. Create a directory to store the backup and give it the correct

permissions.

For example, type mkdir /var/backup and press ENTER. Then
type chmod 777 /var/backup and press ENTER.

. Type BackupMFPM output_file_path or output_device_path and

press ENTER.
The system backs up the database and displays the message:
Backup was conpl eted successfully.

Wul d you like to do another |evel of backup on
dat abase ‘' MFPM ? [default = no]

. Press ENTER.

Doing so selects “no.”

. Type service mfpm-server start and press ENTER.

This restarts Fault and Performance Manager services.
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Restoring the Database

Required
materials

Procedure

Only the root user should execute the procedure to restore the
database.

You can execute the RestoreMFPM utility to restore the database
from the backup file or the archive device.

You will need the following materials and information:

Root login and password

File name or device name to back up the database

Complete the procedure below to restore the database.

. Close all windows and applications.
. Optional. Connect the archive device.
. At the login prompt, type root and press ENTER.

. At the password prompt, type the root password and press

ENTER.

. Type service mfpm-server stop and press ENTER.

This shuts down Fault and Performance Manager services.

. Type RestoreMFPM input_file_path or input_device_path and

press ENTER.

The system displays a series of messages, which takes
several minutes. Then the system displays the prompt:

During the roll forward, would you like to
apply records fromthe database’'s current |og
file in addition to any archived records?
[default = yes]

. Type N (no) and press ENTER.

The system restores the database and displays the message:

Restore was conpl etely successful.

Woul d you like to do another |evel of restore on
dat abase ‘' MFPM ? [default = no]
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8. Press ENTER.
Doing so selects “no.”
9. Type service mfpm-server start and press ENTER.

This restarts Fault and Performance Manager services.

Administering Alarm Notification Services

Script
directories

Alarm
notification
options

A CAUTION:

Fault and Performance Manager offers a notification feature that, when
used with third-party applications can (for example) page you when
Fault and Performance Manager receives an alarm. Only a system
administrator or a root user who knows Linux shell programming
should perform this task.

The /usr/local/avaya/mfpm/bin directory contains the sample scripts
listed below:

e DEFINITY_ARS

e AUDIX_ARS

e CMS_ARS

¢ CONVERSANT_ARS

e TT_ARS

System administrators can choose to use the pager or email features in
Fault and Performance Manager or edit the scripts to enable third-party
products such as:

o Vytek, TeleAlert

e Peregrine, Alarm Response Service (ARS)

Customers are solely responsible for the purchase, installation,
and maintenance of third-party software products.

Description of Alarm Notification Options

The tables below outline the alarm notification options that are available
in Fault and Performance Manager or from third-party vendors.
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Fault and The table below contains the description of product options within
Performance Fault and Performance Manager.

Manager

options

Table 6. Fault and Performance Manager notification options

Option Description

CU Pager Pages the system administrator and sends a code that
identifies the type of alarm, alert, or error received
from the managed system.

Email Sends an email message to the system administrator
that contains detailed information for the alarm, alert,
or error received from the managed system.

TeleAlert The table below contains the descriptions of the notification
options options in Vytek’s TeleAlert.

Table 7. Vytek notification options

Option Description

Alpha Page Pages the system administrator and sends a code that
identifies the type alarm, alert, or error received from
the managed system.

The alpha page also confirms that the system
administrator received the page. The page repeats
until the system administrator responds to the page.

Voice Page Sends a voice page to the system administrator and
sends a code that identifies the type of alarm, alert, or
error received from the managed system.

AUDIX Calls the system administrator’s AUDIX number and
leaves a voice message that contains the detailed
information for the alarm, alert, or error received
from the managed system.
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Peregrine The table below describes the notification options in Peregrine’s ARS
option product. The sample script only supports ticketing. The Peregrine
product supports voice page and email notification.

Table 8. Peregrine notification option

Option Description

Ticket Creates a trouble ticket that contains the historical
information for the alarm, alert, or error received
from the managed system.

DEFINITY_ARS Script

The NMSI looks for the DEFINITY_ARS script when one of the following
events occur:

e NMSI receives an alarm trap from the managed nodes listed
below:

— MultiVantage solutions
— MCU

e NMSI receives an exception event from Fault and Performance
Manager for these managed nodes

Then the NMSI calls the script and passes the values listed below to the
alarm notification program. If a value is not defined, then the NMSI
assigns the alarm the string "NULL_FIELD."

Alarm notification values:

1. System name

2. Error description

3. New status severity

4. Old status severity

5. Product ID

6. Alarm sequence number
7. Alarming Port

8. Maintenance object name

9. On board fault
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10. Type of alarm

11. Alternate name for the device

12. Describes the external device

13. Product Identifier of external device
14. Building location of external device
15. Address of external device

16. Restart date time

17. Restart level

18. Restart carrier

19. Restart craft demand

20. Restart escalated

21. Restart interchange

22. Restart unavailable

23. Restart cause

24. Restart speA release

25. Restart speB release

26. Restart speA update

27. Restart speB update

AUDIX_ARS Script

The NMSI looks for the AUDIX_ARS script when one of the
following events occur:

e NMSI receives an alarm trap from the managed nodes listed
below:

— DEFINITY AUDIX
— Intuity AUDIX
— Intuity Interchange

e NMSI receives an exception event from Fault and
Performance Manager for these managed nodes
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Then the NMSI calls the script and passes the values listed below to the
alarm notification program. If a value is not defined, then the NMSI
assigns the alarm the string "NULL_FIELD."

Alarm notification values:

1. System name
2. Product ID
3. Alarm sequence number

4. Source of the alarm:

— DEFINITY (for DEFINITY AUDIX)
— Intuity Interchange

5. Error description

6. New status severity

7. Old status severity

8. Alarm location

9. Alarm date

10. Alarm time

11. Resource

12. Fault code

13. Module ID

14. Event number

15. Count number

CMS_ARS Script

The NMSI looks for the CMS_ARS script when one of the following
events occur:

e NMSI receives an alarm trap from the Call Management System
(CMS)

e NMSI receives an exception event from Fault and Performance
Manager for the CMS
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Then the NMSI calls the script and passes the values listed below to
the alarm notification program. If a value is not defined, then the
NMSTI assigns the alarm the string "NULL_FIELD."

Alarm notification values:

8.

9.

System name

. Product ID

. Alarm sequence

Error description

. New status severity

Old status severity
Product type
Version

ID value

10. Number

11. Name

CONVERSANT_ARS Script

The NMSTI looks for the CONVERSANT_ARS script when one of the
following events occur:

NMSI receives an alarm trap from the CONVERSANT
system

NMSI receives an exception event from Fault and
Performance Manager for the CONVERSANT system

Then the NMSI calls the script and passes the values listed below to
the alarm notification program. If a value is not defined, then the
NMSI assigns the alarm the string "NULL_FIELD."
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Alarm notification values:

10.

11.

12.

13.

14.

System name
Product ID
alarm number
Error description
New status severity
Old status severity
Location
Date
Time

Resource

Fault code

Module ID

Event number

Count number
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This chapter describes the purpose of and navigational instruction
for the windows within Avaya MultiVantage™ Fault and
Performance Manager (Fault and Performance Manager). In this
chapter you will learn about the following windows and processes:

e Executing auto discovery on Fault and Performance
Manager HP OpenView system

e Executing auto discovery on Fault and Performance
Manager stand-alone system

e Starting the Fault and Performance Manager client from the
Linux server

e Exiting the Fault and Performance Manager client from the
Linux server

e Starting the Fault and Performance Manager client from a
web browser

¢ Exiting the Fault and Performance Manager client from a
web browser

e NMS maps
e Map commands

¢ Online Help system

Executing Auto-Discovery

This section is for NMSI Fault and Performance Manager systems
only.

Auto-Discovery is a feature of your NMS that automatically gathers
information about the managed nodes (voice elements) in your
telecommunications system, and presents that information
graphically using icons and maps. Auto-Discovery creates and
updates the icons and submaps from data received from Proxy
Agents that are connected to the managed nodes.
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To execute Auto-Discovery, complete the following steps.

1. From the Linux server, type PAdiscovery
2. Enter the IP address of the Proxy Agent computer.
3. Enter the read and write community strings.

4. From the HP OpenView server, click VisAbility>System
View>Refresh Entire Map,

Starting the Administrative GUI

The Fault and Performance Manager Administrative GUI lets you specity
data collection parameters, create and save report definitions, and
schedule reports. You must start this GUI to perform any of these tasks.

Procedure Complete the procedure below to log in and exit Fault and Performance
Manager, and to log off the NMS from the root map.

1. At the login prompt, type the login name and press ENTER.
2. At the password prompt, type the password and press ENTER.
3. Open a terminal window.

The system displays the Linux prompt.

4. At the Linux prompt, type . /etc/avaya/mfpm/ENV and press
ENTER.

5. Type: cd /usr/local/avaya/mfpm/bin/ and press ENTER.

6. Execute one of the following scripts to access the information.

— . /MFPMgui - launches Fault and Performance Manager. Add
a voice system name at the end of the command to launch the
application for a specific voice system.

— . /PAdiscovery - launches Fault and Performance Manager to
add new Proxy Agents.

— . /MFPMgui_RM - launches the Fault and Performance
Manager Report Manager.
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— . /MFPMgui_Exc - launches the Fault and Performance
Manager Exception Report for all MultiVantage
solutions registered in Fault and Performance Manager.
Optionally, add the voice system name at the end of the
command for the MultiVantage solution Exception
Report for a specific voice system.

Exiting the Fault and Performance Manager
Client from the Linux Server

Clicking the “X” box in the upper right corner results in
unpredictable behavior. To exit the application, follow the steps
below:

1. To exit Fault and Performance Manager, from the menu bar
on any screen, click File > Exit.

The system exits the product and displays the Root map.
2. To log off the NMS, click File > Close.

The system displays the Linux login prompt.

Starting the Fault and Performance Manager
Client from a Web Browser

When you start the Fault and Performance Manager client from a
web browser, you can only view; you can not make changes. You
can start the client from a browser only if the browser meets the
requirements specified in the VisAbility Management Suite
Services Support Plan. Contact your client executive for the
requirements.

Procedure Complete the procedure below to start the Fault and Performance
Manager client from a web browser.

1. Open a supported browser.

2. At the URL address line, type the IP address for the Linux
server where Fault and Performance Manager is installed
and press ENTER.

The system displays the VisAbility home page.
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3. Click on Products.
The Product page appears.
4. Read the installation information.
5. Click Download.
A dialog box displays the progress of the download.
6. Click Open.
A dialog box displays vims_client_cdexe file downloading.
The WinZip Self-Extractor dialog box appears.
7. Click Setup to unzip the file.

The system displays the Avaya VisAbility Management Suite
Network Management Client for Window screen.

8. Click Install Network Management Client Products.

The system indicates that it is preparing the wizard and then
displays the Welcome screen.

9. Click Next and follow the prompts.
10. At the URL address line:

a. Type the IP address for the Linux server where Fault and
Performance Manager is installed and at the end of the
address

b. Type /mfpm
C. Press ENTER
The Java Plugin Security Warning appears.
11. Click Grant this Session.

The Avaya VisAbility Management Suite screen displays and Fault
and Performance Manager launches.
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Starting the Online Help

To start the online help, with Fault and Performance Manager
open, choose Help>Contents.

The online help system replaces the user guide for Fault and
Performance Manager. The help screens contain the information
listed below:

e Description and purpose of the screen

e Procedure to complete appropriate tasks on the screen

¢ Links to Related topics for more information

Help button A Help button is also available on many tabs, panels, and dialog
boxes. Clicking the Help button displays the help topic for the
current screen.

Exiting the Fault and Performance Manager
Client from a Web Browser

To exit the Fault and Performance Manager client from a web
browser, choose File>Exit.

Fault and Performance Manager Integration
with NMS

Before you integrate Fault and Performance Manager with the
NMS, you must have installed the Fault and Performance Manager
client on the HP OpenView Windows 2000 server. After installing
the client, you must run mfpmconfig again to configure the

HP OpenView server config service TCP port number.

Understanding the NMS Maps

The Network Management System Integration (NMSI) is one of
the programs in Fault and Performance Manager, and is intended
to integrate Fault and Performance Manager into the HP OpenView
network management application.

48 Avaya MultiVantage™ Fault and Performance Manager Installation and Configuration



Getting Started

NMS maps

Root Map

Proxy Agent
submaps

This capability does not exist for Linux systems. Linux users execute a
Linux command in the command prompt line to integrate Fault and
Performance Manager into their own existing application.

This integration allows you to monitor your Avaya telecommunication
elements and data networks from the same workstation.

NMSI uses the Auto-Discovery program to find and transmit system data
from the managed nodes (supported systems) to the NMSI programs.

The NMSI uses the data received from Auto-Discovery to create and
update the NMS maps, which include:

e NMS Root map/Avaya Root map

e Avaya Fault and Performance Manager submap
¢ Avaya USA and state submaps

e Custom submaps

The sections below describe the objects (system icons and connection
lines) that display on the map and the color schemes that indicate the
current status of the objects.

The root map on the Network Management System (NMS) name
“default” is the initial user interface to Fault and Performance Manager.
Fault and Performance Manager creates additional submaps on only one
NMS map.

NMSI places executable icons for the new maps on the root map. These
icons represent the default location submaps that you administered on
Proxy Agent for the managed nodes. The submaps options include:
Generic, USA and associated State maps, and Custom.

The icon names that display on the root map are:

e Avaya Fault and Performance Manager MAP identifies a Generic
submap.

e Avaya USA MAP identifies the USA map and associated state
supmaps.
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e Custom submaps will be used if defined by the user. Custom
submaps need not have an associated icon, however, if an
icon is used, be aware that the Custom submap is found by
using the submap name, not the icon title. During discovery
if a Custom submap is not found on which a object is to be
placed the object will be placed on the Generic submap.

Proxy Agent The table below contains Proxy Agent icon colors that display on
icon colors HP OpenView maps. The colors indicate whether or not Proxy
Agent is responding to requests.

Table 9. Proxy Agent Icon colors
Object HP OpenView Color

Proxy Agent icon Dark Blue = Unknown. Proxy Agent is not
responding

Green = Normal
Cyan = Warning. Proxy Agent is responding,
but is not honoring SNMP requests. Indicates

that the SMNP community string for the NMS
is incorrect.

Red = Major. Proxy Agent failed to forward an
alarm to INADS on its last try.

Fault and Fault and Performance Manager maintains a list of active
Performance exceptions for the systems listed below:

Manager icon

colors e MultiVantage solutions

e Multipoint Conferencing Unit (MCU)
e Survivable Remote Processor (SRP)

Fault and Performance Manager treats the MCUs and SRPs as
MultiVantage solutions.
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The table below contains the MultiVantage solution icon colors and
Proxy Agent line connections that display on the Fault and Performance
Manager maps.

Table 10. MultiVantage Solution icon colors

Object HP OpenView Color

MultiVantage Dark Blue = Unknown. Proxy Agent
solution icon is not responding

MCU Green = Normal

SRP Salmon = Dispatched

Cyan = Warning
Yellow = Minor
Orange = Major
Red = Critical
Line connections to | Black = Up
Mult?Var%tage Red = Down or Other
solution icons
Yellow = Init (initiating)
Cyan = Off

Salmon = Idle for dynamic connection]

Other The NMSI only supports alarm traps from Proxy Agent for the systems
system icon below:
colors

e DEFINITY AUDIX releases 3.1 through 4.0

e Intuity AUDIX release 4.3 through 5.1 (with or without the
remote maintenance board)

¢ Intuity Interchange release 5.1 through 5.3
e (Call Management System (CMS) R3V6 through R3V8
¢ CONVERSANT release 7.0

The Fault and Performance Manager maps provide only telnet support to
the products above.
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The table below contains the other system icon colors and Proxy
Agent line connections that display on the Fault and Performance
Manager maps.

Table 11. Other system icon colors

Object HP OpenView Color

Other system icons Dark Blue = Unknown. Proxy Agent is
for: not responding

DEFINITY AUDIX Green = Normal

Intuity AUDIX Salmon = Dispatched

Interchange Cyan = Warning

CMS Yellow = Minor

CONVERSANT Orange = Major

Line connections to | Black = Up. Proxy Agent is running and
other system icons available to receive alarm traps.

Red = Proxy Agent is stopped and cannot
receive alarm traps.

Executing Commands from NMS Maps

* Note: Linux users execute the Fault and Performance
Manager GUI script to launch the Fault and
Performance Manager interface.

The NMS Integration (NMSI) program allows users to execute
various commands from any of the NMS maps. Most of the
commands perform operations on the systems that display on the
selected map.

Users can execute the commands in three ways:

¢ Select a command from a menu
¢ Double-click an object on the map
e Select objects from the third mouse button

The sections below explain the commands and the execution
options.
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Description of Commands

The table below lists the commands that users can execute from any
NMS map. The Description column describes the result of the command.

Based on the result of the command, the NMSI updates the NMS maps,
changes the color of the status, and displays the appropriate NMS and
Fault and Performance Manager windows.

Table 12. NMS Map commands

Command Description

Network
Manageme
nt
Application

(Fault and
Performanc
€ Manager
product)

Report
Generator

Exception
Report

This command displays the main window, which contains
the systems group navigation tree and configuration and
status window.

If you execute this command for a specific MultiVantage
solution on the NMS map, then the command opens the
main window only for the selected MultiVantage solution.

This command displays the Report Generator window in
Fault and Performance Manager.

This command displays the results of a Fault and
Performance Manager Exception report.

If you execute this command for a specific MultiVantage
solution on the map, then the report shows exceptions only
for the selected MultiVantage solution.

10of 5
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Table 12. NMS Map commands

Command Description

Discovery

The Discovery process is primarily driven by the Fault and
Performance Manager database and collection process. The
database is used because not all Avaya products that Fault
and Performance Manager deals with are IP based. Only IP
Phones are exclusively obtained from the set of objects that
HP OpenView has discovered. Therefore, the Discovery
process will place icons on one of the submaps and show
connectivity between that device and others without regard
to whether HP OpenView can discover that device, except
for IP phones.

Because the Discovery process is driven by the Fault and
Performance Manager database, it works primarily in a top
down manner; that is, from Proxy Agents out to managed
nodes, managed nodes out to boards, boards out to IP
Phones. The case where IP Phones connect directly to a voice
system discovery works in the reverse order, that is from the
IP Phones to the voice system. A Discovery must be
performed to discover new Proxy Agents and new managed
nodes. When the Discovery command is repeated, the icons
for all objects discovered by Fault and Performance Manager
will be removed, the underlying HP OpenView object will
remain in the database.

During the Discovery process, a flag is shown on the bottom
of the HP OpenView display. At the end, a dialog box
indicates that the Discovery is complete. The time needed to
perform a Discovery depends primarily on the size of your
network. For the Discovery command to run, the following
conditions must be met:

¢ The Fault and Performance Manager server must be
operational.

e HP OpenView must have a Read-Write map opened.

e A connection must be established between HP Open
View and the Fault and Performance Manager server
process, NmsiServer. Refer also to the Fault and
Performance Manager Login, Rediscover C-LAN, and
Rediscover DEFINITY commands.

e Media Gateways and IP phones must be SNMP
manageable from HP OpenView.

20of5
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Table 12. NMS Map commands
Command Description

Login The Login establishes a connection between the Fault and
Performance Manager server and HP OpenView. A login is
done automatically when the HP OpenView GUI is started.
However, if the Fault and Performance Manager server is
brought down while the HP OpenView GUI is running, a
connection can be established using the Login command.

You can run the Login command even if a login already
exists; this does not cause problems. In fact, running the
Login command is the simplest way to verify that a
connection exists between HP OpenView and the Fault and
Performance Manager server. If a connection cannot be
established, an error message pops up on the screen. If the
connection between HP Open View and the Fault and
Performance Manager server is lost, all interaction between
HP OpenView and the Fault and Performance Manager
server is lost as well.

Rediscover This command is not supported for Avaya S8300 voice

DEFINITY | systems. Once a voice system is selected, if not an ICC voice
system, the Rediscover DEFINITY command works just like
the Discovery command, only on a per-voice system basis.
Also see the Discovery command.

Rediscover | This command is only available on a C-LAN. Once a C-LAN

C-LAN is selected, the Rediscover C-LAN command is enabled. This
command works just like the Discovery command, only on a
per-C-LAN basis. Also see the Discovery command.

Cleanup The Cleanup DB command removes objects created by the
DB Discover command, as long as the object has no associated
icon.

Acknowled | This command turns off alerting for a selected system icon
ge Alert and changes the color status to normal.

Set Alert to| This command sets the alert level to Minor for the managed
Minor nodes listed below:

e DEFINITY AUDIX
e Intuity AUDIX
e Intuity Interchange
¢ Call Management System (CMS)
e CONVERSANT
¢ Avaya legacy system
30f5
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Table 12. NMS Map commands

Command

Description

Show
Managed
Nodes

Connection
Status

Show MIB
Values

Start
Connection

Stop
Connection

Telnet to
Proxy
Agent

This command displays the Managed Nodes list for a Proxy
Agent. The list contains the current settings for all the
managed nodes administered on the specific Proxy Agent,
including:

¢ Node Type and Node Name

e Connection Type (static or dynamic), Connection
Status, and Timeout minutes for dynamic connections

e Submap type
¢ Object Label which is the Node Name

This command displays the Connection Status window for a
MultiVantage solution, MCU, or Survivable Remote
Processor (SRP). The title bar on the window contains the
name of the managed node.

The Connection Status list contains the information below:
e Connection Type (static or dynamic)
e Connection State (Up, Off, etc.)
e Counters for connection statistics
¢ Alarm Forward Status

This command displays screens for viewing configuration,
fault and performance information via the NMS platform
menus.

This command instructs the Proxy Agent to start a
connection to a MultiVantage solution, MCU, or SRP.

The NMSI sets the connection state to init (initiating), which
signals the Proxy Agent to connect to the managed node.
The NMSI also changes the color of the connection line to
the init color to indicate the current status.

This command drops the connection between a Proxy Agent
and a MultiVantage solution, MCU, or SRP.

The NMSI sets the connection state to off, which signals
Proxy Agent to drop the connection. The NMSI changes the
color of the connection line to warning or unknown.

When Proxy Agent drops the connection, NMSI again
changes the color of the connection line to off.

This command displays the telnet window to Proxy Agent.

From the telnet window, users can log in to Proxy Agent and
initiate an emulation session to cut-through to the managed
node.
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Table 12. NMS Map commands

Command Description

Telnet to This command is for IP-connected nodes associated with a
Node Proxy Agent. Users can telnet directly to the node rather
than going through Proxy Agent.

Refresh This command retrieves the status of systems that have
Alarms and| dynamic connections to the Proxy Agent.
Errors

The NMSI requests that Fault and Performance Manager
update exception data for alarms and errors for selected
MultiVantage solutions, MCU, and SRP systems. After Fault
and Performance Manager updates the alarm and error data,
the NMSI updates the system icons on the NMS maps.

In addition, the NMSI adds an item called G3 MIB Values to
the HP OpenView Fault menu.

e When users select a MultiVantage solution icon from a
map and the G3 MIB Values from the menu, the NMSI
displays a list of MultiVantage solution MIB groups.

e When users select one of the MultiVantage solution
MIB groups from the list, the NMSI displays the values
of the objects in the MIB group for the selected
MultiVantage solution.
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Glossary and Abbreviations

A

ATAC
See “Avaya Technology and Consulting (ATAC)” on page 9.

M

managed node
In this document, a managed node is any system (voice system or otherwise) that can be viewed and moni-
tored using Fault and Performance Manager and Proxy Agent.

MultiVantage software
The call processing software that runs on MultiVantage solutions. Formerly known as DEFINITY software.

MultiVantage solution
Any of the products that run MultiVantage software. Formerly known as DEFINITY system, DEFINITY ECS,
switch, PBX, or voice system.

N

Network Management Server
This is the Windows box that you can install Windows-based VisAbility Management applications on.

Network Management System
A system that lets you monitor the health and status of devices on your data network. For example,
HP OpenView.

R

RNIS
See “Avaya Remote Network Implementation Services (RNIS)” on page 9.

S

supported systems
In this document, a “supported system” is any of the voice systems or adjuncts that Proxy Agent works with.
See “Supported Systems” on page 15.

SNMP
Simple Network Management Protocol.

System Management Server
This is the Linux box that you install Fault and Performance Manager or Proxy Agent on.

T

TSO
See “Avaya Technical Service Organization (TSO)” on page 10.
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